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DOE's Building Energy Codes Program is an information resource
on national model energy codes. We work with ather
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The Program recognizes that energy codes maximize energy efficiency only
when they are fully embraced by users and supported through education,
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Desktop Software Tools Fre

| \/I Web-Based Tools

COMcheck-EZ" fi](

Printed Materials

COMcheck-Web"

Compliance Guides

ff ] COMcheck" Prescriptive Tables

Package Generator
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» PowerPoint presentations with
faculty notes

» Case studies
» Online training
» Online videos

Case Study — REScheck Software

Jones Reskdence. Bowmnan, 5C

Case Study - COMcheck-EZ Software

Sigma 4 Office Budding
HRichiland, WA







&'f Building Energy Codes
RESOURCE CENTER

’ SEARCH: IGraphics j FOR: |duct system approach HYAC » SEARCH BROWSE: | Select a Topic... j

Home  About the Resource Center  Ask a Question  Advanced Search  Help

2. Graphics Search Results & Printer-frisncly Format
Keywords: gt system anoroac HWAC

Wiewing: 1-0 of 92 ADDITIONAL RESOURCES

Articles
== ' Online Toals
== I g sisma O Presentations
=i - of® vidogs
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Prescriptive Approach Trade-off Approach ree

: » Trade-off between components
* Simple, fast and easy * Provides design flexibility
* Generally most stringent * Requires area & U/R-factors

* Requires minimum input
* Based on climate and

WWR Windows version or

* Uses a prototype Mac version
building @ T\/Il
@ Printed guides on COMcheck-EZ"
www.energycodes.gov

I.ﬂi] COMcheck”

Package Generator

All COMcheck tools available from www.energycodes.gov



Commercial New Construction, Alterations and Additions

» Commercial Buildings include all buildings except
o Single family
o Low rise multi-family < 3 stories in height

» State Dependent

» Not all states have the same code, some states have state-specific
energy codes

e Check to see what code is applicable in your state and if COMcheck
IS accepted

e Status of State Codes
e http://www.energycodes.gov/implement/state_codes/index.stm




Building System Compliance Options

Preseriptive
Optien
Envelope
Mandatie Energy Code
— Provisions Frziels O)ff .
Lighting (required for all Compllance
compliance options)
sEShen e Total Building
Pefennance
HVAC

I
SWH




Building Envelope

e construction assembly (materials &
insulation levels)

o windows, doors & skylights
Mechanical Systems
Service Water Heating

Lighting Systems
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» Mandatory Requirements:
e Moisture Control
e Air Leakage

» Climate Specific
Requirements:

Roof
Above Grade Walls
Below Grade Walls
Floor
Slab

Skylights, Windows, and
Doors
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» Envelope
» trade-off calculations are based on envelope loads only
» defines a proposed design and a budget design

» Lighting
» Watts/square foot (LPDSs)

» Mechanical

» short wizard to customize a list of requirements applicable to the
system identified
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Information you need to use COMcheck-EZ:

1.

2.

3.

~EeRs

General Understanding of Windows-based Computer
Programs

Basic Information about the Builder and Project to be
Constructed

Building Plans including Exterior Wall Areas, Glazing
Areas, Roof/Celling Areas, Basement Wall Areas, etc.

Insulation R-Values, NFRC Glazing and Door
U-Factors, eftc.

Lighting
Heating and Cooling System Efficiencies
Service Water Heating

14
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Microsoft\ord {'ﬂl Untitled.cck - COMcheck-EZ Code: 2003 IECC
File Edit View Options Bels(s Help
O = H i B® 90.1 (89) Code

901 (99) Standard
Project E I |
| Envelope | | o)+ 2001) standara

1998 [ECC

2001 [ECT Froject Information

FProject Type
(=) Mew Construction (O Additi

Building Use

- f.VEI.'.IEIS [ECC | Project
= wWhole Building | EXpand the SCI’een

Zeorgia

Whole Buidy  L0USiana | like other programs.

Massachusetts

Minnesota
Mew York

Vermant Let’'s take a closer
look at this area.

Click to select building ty

Envelope andior Mechanical Compliance Only

o Check this bhox it Lighting Compliance will not he used.

Valid huilding use areals) must be pravided on the Project scraen. Envelope TB—D—! Lighting | TED |

| Choose the state inwhich the building will be located.




@il Untitled.cck - COMcheck-EZ

Code: 2003 IECC

File Edit View Options [[SULEY Help
0w [l % B g 901 ('EQ}C:::N

'99) Standard

Project T
I Envelope 90.1 (208

State ||

1993 [ECC

Title Bar

Addition

Menu Bar

Toolbar

I — s
2001 I[ECC
Building Lse v 2003 [ECC
%1 Whale pace-By-Space)
Geargia ¢
whole | Lousiana Area Wit

Massachusetts

Click to select buildingty.  Minnesota

Mew York
Yermont

Make sure the
correct code

IS chosen
Design
Dacument Authar
Motes

Envelope andior Mechanical Compliance Only

O

Check this box if Lighting Compliance will not be used.

Yalid building use areafs) must be provided an the Project screen.

Ervelope Lighting

IChnDse the state inwhich the huilding will be located.




{'ﬂ EZ-Casestudy.cck - COMcheck-EZ |

Code: 2001 IECC

File Edit “iew Options Code Help

KMechanical )(

Project | Envelope Lighting

W azhinguon

City | Richland v|

Building Llse

() wWhale Building (%) Area Category (Space-By-Space)

|

Area Categorny Area \ZQHE

&dd Categaory

Office - || 15349 1.5

2 |Corridar, Restroom, Support Ares = || 3535 0.5
3 |Kitchen = 503 22

ohby - Cther - 340

Total Area 20532

E Four Main Screens I:

Froject Type
(#) Mew Construction (O Addition

Froject Information

Froject Mame

Building Use
* Whole Building

Richland, WA 9

Designerﬂ:nntral * Area Category

Joe's Canstruction
Gearge, Washington

Cocument Author
KRT :

| Compliance Results

Motes
ing construction majar rennaovation with lighting maodifie
nn (existing fiduresand existing mectianical equipment.

-10% )
_—

Lighting

HChnnse the state inwhich the building will be located.




& EZ-Casestudy.cck - COMcheck-EZ
File Edit Wiew Options Code Help

x H 4 BB X3

&

Code: 2001 IECC

Mechanical

@ Envelope Lighting

State | GiERLgslEN

City | Richland w |

Building Use | Construction Type

[ Add Categary ]

(1 whale Building (%) Area Category (Space-By-Space)

Area Category Area WA
1 [Sffice | 15849 15
2 |Corridor, Restroom, Support Ares w || 3535 0.5
3 |Kitchen -=| 505 2.2
4 (Laobby - Other - 240 1.0

Basic Information

Total Area

20532

Froject Type

{(*) Mew Construction

Fraoject Infarmation

Froject Hame

() Addition

Sigma 4 Office Building

Richland, YA 99352

70 George Washington Way

DesignerCantractar

Joe's Construction
George, Washinotaon

Document Authar

KRT

MHotes

ing construction majar rennovation with lighting modifie
o (existing fixturesand existing mechanical equipment.

Envelope

+2d%

Lighting

HChDDSE the state inwhich the building will be located.




@i EZ-Casestudy.cck - COMcheck-EZ

File Edit “iew Options Code Help

D $ R X2 &

Code: 2001 |IECC

Project | Envelope Lighting

KMechanical

State | W azhington

Mew ok,
Marth Caralina
Marth D'akota
Chia
Oklahoma
Oregon
Fernsylvania
Fuerto Rico

ity

Builg

Space-By-Space)

Rhode [zland Ares Wk A2

South Caralina

South Dakota

Tenneszee L 13

e 3838 (=

Utah 505 | 2.2
340 1.0

Total Area | 20632

Froject Type

(#) Mew Construction

Froject Infarmation

Froject Mame

() Addition

Sigma 4 Office Building
370 George Washington Way
Richland, WA 99352

DesigherContractar

Joe's Caonstruction
George, Washington

Document Authar

KRET

Miotes

ing construction major rennavation with lighting modifie
on (existing fiduresand existing mechanical eguipment.

+22%

Envelope

Lighting

Choose the state inwhich the building will be located.




{'ﬂ EZ-Casestudy.cck - COMcheck-EZ |

Code: 2001 IECC

File Edit “iew Oplions Code Help

NS P L hR XE &
F‘ruiect( Envelope )Lighting Mechanical

[ R oof ][Wt ' all ][ [rk. S all ][ W indow ][ Croor ][ B azement ][ Floor

Construction cely Sl Projection
Component Azzembly ; Grozs Area [nzulation Inzulation J-Factar | SHGC |
Details Factor
R alue R alue

Building
1| b Roof 1 Mon-Ywood JoistRatterTr... = 20552 ft2 13.0 g6.0 0.040
2 | [=-Exterior Wl 1 hetal Frame, 16" o.c. - g172 ft2 100 ono 0145
3| e Wirncone 1 hietal Fratme, Doukle Pane || Glazing: Tin... * 895 ft2 0.630 0.y 0.50
4 | e Door Glass - | Glazing: Cl... - 126 ft2 0.920 0.47 0.00
5 e Dioor 2 CpacUe - 21 it2 0.7o0
= Floor

Main Building Envelope

« Use the blue-on-white buttons at the top of the Envelope screen to
create a list of building components present in your proposed
design. Each component you select is added to the building
components displayed on the Envelope screen.

o Gross area (or perimeter) of assembly components, cavity R-value ,
continuous R-value, assembly U-factor , construction details, SHGC,
and/or projection factor are entered by the user.

+2d%

Ervelope Lighting

"Headﬁ;




&ii EZ-Casestudy.cck - COMcheck-EZ
File Edit Wiew Options Code Help

e Hd § BR Xi= &

Code: 2001 IECC

Project | Envelope | Lighting KMechanical

Hoof || Skylight || Eut. W all || [k, W all || W indons || Croor || B azement || Floor |

Building Components are added by clicking on these.

22

: Cavity C
Construchion :
Component Azzernbly ) Gro#t Area |rizLlation I
Details
H-Walue
Euilding
1 | i Roof 1 Mon-Yood Joizt/R 20532 ft2 19.0



il EZ-Casestudy.cck - COMcheck-LEZ Code: 2001 IECC
File Edit “iew Options Code Help

L@ H f R Xi= &

Project | Envelope | Lighting KMechanical
Hoof [ Sk plight ” Eut. Wafall ” Ik, wadall ” Wi ” Cronor “ B azenent ” Floor ]
Consgtruction Eaﬁ.fit_y e
Azzembly . Grozs Area Irzulation I
Dretails
H-\alue
Building N
1 > ----- Foof 1 MonSyood JoistiFatterTr... 'r| 20532 fi2 19.0

Step 1: Click on Roof

23



i EZ-Casestudy.cck - COMcheck-EZ Code: 2001 IECC
File Edit “iew Options Code Help

hEE » 2R Xi& &

Project | Envelope | Lighting KMechanical
| FRoof || Skylight || Extwal || Inbwal || wind

i Step 2: m

-l° Select Roof Type (different roof types
Componert Aszembly and any number of skylights can be achs
added individually.) _

Building I

1 | - Roof 1 20532 ft2 19.0 a.0 0.040
2 | &-Extarior Wall 1 g172  |f2| 100 0.0 0.145
30 ewindow Mon-‘Wood Joist/Rafter | Truss (... 883 ft2 0.650
4 Doar 1/ Structural Slab :l-\ i 128 i LErl
E ; ~-Door 2\ Metal Roaf without Thermal Blacks } 21 fte S
6 | “-Floor 1 \ Metal Rioof with Thermal Blocks - NS el ft

Other




| EZ-Casestudy.cck - COMcheck-EZ Code: 2001 IECC
File Edit “iew Options Code Help

hEeE 2R Xi& &

Project | Envelope | Lighting Mechanical
| R oot || Skylight || Eut. wall || [k, s all || W ird o || Croar || B azement || Floar
: Cavwvity Continuaus
Construchion : :
Component Bzzembly . Grosz Area Inzulation Inzulation L
Dretailz
R - alue F-\alue
Builditig NN
1 | “-Roof1 Mon-vood Joist/RafterTr... - ( 20532 ) ft2 19.0 8.0
2 | =-Exterior vl 1 Metal Frame, 16" o.c. - ft2 10.0 0.
3| > ----- il 1 Metal Frame, Double Pane | |Glazing: Tin... * 995 ft2
4 ..ok 1 Glass * || Glazing: ... w 126 ft2
3 ~Door 2 Dpacue - 21 i
B | e Floor 1 =lab-On-Grade:Unheated  «||Insulation: ... - atay ft

Step 3:
» Add square footage (In this case 20532 square feet)




i EZ-Casestudy.cck - COMcheck-EZ Code: 2001 IECC
File Edit “iew Options Code Help

hEeE 2R Xi& &

Project | Envelope | Lighting Mechanical
| R oot || Skylight || Eut. wall || [k, s all || W ird o || Croar || B azement || Floar
: Cavwvity Continuaus
Construchion : :
Component Bzzembly . Grosz Area Inzulation Inzulation L
Dretailz
R - alue F-\alue
Building |~
1 | “-Roof1 Mon-vood Joist/RafterTr... - 20532 #2190 8.0 \
2 | [=-Exterior Wl 1 Metal Frame, 16" o.c. - a7 ft2 10.0 y
3| > ----- il 1 Metal Frame, Double Pane | |Glazing: Tin... * 995 ft2
4 ..ok 1 Glass * || Glazing: ... w 126 ft2
5 foee Dioor 2 Gpaque - 21 ft2
B | e Floor 1 =lab-On-Grade:Unheated  «||Insulation: ... - atay ft

Step 4:

» Add insulation R-Value (R-19 cavity and R-8.0 continuous in this example)




(i
File Edit “iew Options Code Help
O’ d £ i X LS

EZ-Casestudy.cck - COMcheck-EZ

=

Code: 2001 IECC

Project | Envelope | Lighting

Kechamcal

| Hnnfm Skylight || Eut. wfall || [k, s all || W ird o || Croor || B azement || Floor
N _ _
C : Cavity Continuous
anztruchion : :
Component Azzembly ) Grogs Area Irizulation Irizulation
Details
A ’\H-Ualue R-alue
2 7
Building 3 4 )
1 | -Roof1 Mon-wood JoistRafterTr... - 20532 ft2 13.0 .0
2 | [=-Exteriorwall 1 |Metal Frame, 16" o.c. - 8172 ft2 10.0 0.0
30 bindow 1 Metal Frame, Double Pane  « |[Slazing: Tin...'-'| 993 ft2
4 Dot Glazs — ' oSy | {12
RS Doar 2 opamue | St€P 1: Click on “Roof” #o
- R slab-0n-Q Step 2: Select Roof type L
Step 3: Add square footage
Step 4. Add insulation R-Value




» 3% of area is exempted
from inclusion in the
proposed and budget
building loads calculations

» Requirements based on
U-value (NFRC tested) or
Default U-value table

Y

ﬂﬁ—-___-'.

TABLE 102.3(1)
LYALUE DEFAULT TABLE FOR WINDOWS,
GLAZED DOOAS AND SKYLIGHTS

SINGLE | DODUBLE
FRAME MATEREAL AND PRODUCT TYFE® GLAZYED | GLAZED

Wetal withonut thermal break i
Crperable {ncluding sliding and i

swinging glars doors} < 12T 087
Fixed . 113 0.69
Garden window 260 i.81
Curtain wall 122 0.7e
Skylight 1.98 1.51
Site-assembled sloped/overbead alazing 1.36 082

Metal with thermal hreak
Operabic (including sliding aod

swinging glass doors) 108 .65
Fixed 1.07 Q.63
Curtain wall 1.11 0.68
Skylight 1.89 1.11
Stte-assembled slopedfoverhend glazing 1.25 {170}

Reinforced vinyl/metal clad wood
Operable (including sliding, and

swinging glass doors) Q.90 .57
Fized 0.Bg {L.36
Skylight 1.75 105

Woodivinylffiberglass
Operable (including shiding and

gwinpinge plass doors) - 0.R9 .35
Fixad 0.8 56
Garden window 231 L&l
Skylight 1.47 024

FarBI: 1inch =254 nm.

1 Glass bleck zsscmblics with mortar but withoot reisforeing ar framing shall
have 5 {value of $.60.

28



|"ﬂ| EZ-Casestudy.cck - COMcheck-EZ Code: 2001 IECC
File Edit “iew Options Code Help

= = S B X5 & Step 1: Click on “Wall”
Project | Envelope | Lighting KMechanical Step 2 Choose Assemb|y B
| Roof |[ Skelight( 1 )Estwall || Intwal || Window || Door
| Step 3. Add square footage
Construction
: : - Gl Step 4. Add the R-Values :
Exterior walls, windows and Dielet 1 P
doors can be added as a total
1 sum or each exposure can be 20532 ft2 19.0 a.0 0040
2 || added separately g172  [f2| 100 0.0 0145
3 bR oy 1 Metal Frame, Double Pane = ||[Glazing: Tin... - 993 ft 0.630
4 | i LDoor 1 Glass * || Glazing: Cl... - 126 ft2 0.920
5| feDoor 2 fz\\;aque - 3\ 21 T‘tf\ 4) 0.700
G > ----- Exterior wyall 2\ ék here to zelect Azse .. 'r|| — D ft2 001
7 | “Floor 1 Wood Frame, Any Spacing | B3 ft

Mekal Frame, 16" o.c.

Metal Frame, 24" o.c,

Metal Wall without Thermal Blocks
Skruckural Masonry Wall b
Other




Code: 2001 IECC

|"ﬂ| Untitled.cck - COMcheck-EZ 3.0 Release 1a
File Edit Miew Options Code Help

DEd 2R XiE &

Project Envelope | Lighting Mechanigaleme
[ R oof ][ Skaylight ][ Eut. wfall ][ . WallﬂLWindnw Croor ][ Eazement ][ Floor ]
Consgtruction iy Uer L e Projection
Component Azzembly . [arozs Area [nzulation [nzulation U-Factor | SHGC
Details Factor
B-Yalue R alue
Builditig
1 indow 1 ol - 1] ft .000 0.00 .00
Metal Frame Single Pane
Metal Frame with Thermal Break » Double Pane
Woaood Frame ¢ Double Pane with Low-E
Wiyl Frame b Triple Pane
Okher Triple Pane with Low-E
Step 1: Choose window type
Step 2: Enter gross area (rough opening)
Step 3: Enter U-Factor, SHGC

Step 4: Projection Factor




Table 102.3(1)

U-Value Default For Windows
Glazed Doors and Skylights

Frame Material and Product Type Single Double
Glazed Glazed
Metal without thermal break
Operable (including Sliding and swinging
glass door) 1.27 0.87
Fixed 1.13 0.69
Garden Window 2.60 1.81
Curtain Wall 1.22 0.79
Skylight 1.98 1.31
Site-assembled Sloped/overhead glazing 1.36 0.82
Metal with thermal break
Operable (including Sliding and swinging
glass door)
Fixed 1.08 0.65
Garden Window 1.07 0.63
Curtain Wall 111 0.68
Skylight 1.89 111
Site-assembled Sloped/overhead glazing 1.25 0.70
Reinforced vinyl/metal clad wood
Operable (including sliding and swinging glass
doors) 0.90 0.57
Fixed 0.98 0.56
Skylights 1.75 1.05
Wood/vinyl/fiberglass
Operable (including sliding and swinging
glass doors) 0.89 0.55
Fixed 0.98 0.56
Garden Window 231 1.61
Skylight 1.47 0.84

Single Pane Double Pane Triple Pane

‘ U=1.00 MU=O.55 M U=037

» NFRC tested and certified
or default window U-value
range

» Use assembly U-value

> All windows must meet or
exceed

31



@il FZ-Casestudy.cck - COMcheck-EZ Code: 2001 IECC
File Edit “iew OQptions Code Help

O 4 Bl X2 &

Project | Envelope | Lighting Mechanical e

[ Hoof ][ Skylight ][ Eut. ‘wiall ][ [k, v all ][ WS ind o ][ Door <” B azement ‘) Floor ]

Canstuchion Cawity Continuous
Component Azzembly . Grozs Area [nzulation [nzulation LI-Fan
Details
R alue R alue

EBuilding
I Roof 1 Mon-wood Joist/RafterfTr... - 205352 ft2 19.0 .0 0.04
2| b Eazement Wall 1 lick here to select Asze... - 0 ft2 0.0 0.0c
3 | [=)-Exterior Wall 1 a172 ft2 100 0.0 0.14
4 Ny 1 Salid Concrete or Masonry = 3" in... = 95& 2 0.6E
3 Findove 2 CMLI <=8" with Emply Cells a ft2 0.0c
5 FWindow 3 CMU =5" with Empy Cells . itz —
7 O MU ==3" with Integral Insulation hd 128 ft2 SEcF
3 N B MU =8" with Integral Insulation ol fte CEit
9 | bEuxterior Wall 2 ] ft2 0.1cC

: Ckher
10| ielnterior Wiall 1 O P e e 0 ft2 (I
11 | blrterior Wiall 2 Click here to select Lzze... - ] ft2 0.1=
12 | “-Floor 1 Slab-On-Grade:Unhested || lnsulstion: ... - E31 ft




Basement Walls

®

®

Wall Height () 'y
mMeasured from the
top of the wall to

the basement floar.

Crepth Below Grade (1)
Measured from the
finished outside grade 'Y

=

0.0

to the bhasement floar.

Enter the specified dimensions in feet (hot inches) in the boxes provided.
Basement walls are walls that are partially or fully below grade.
lgnore portions ofwalls that are more than 10 1 helow grade.

i

| aF. || Cancel

33



gl EZ-Casestudy.cck - COMcheck-EZ Code: 2001 IECC
File Edit “iew Options Code Help

Dz + 2l XiE& &

Project | Envelope | Lighting KMechanical
R oof || Skylight || Eut. wwfall || [k, s all || WS ind oy || Draor || B azement || Floor
: Hrozs Area Caity Continuo
Component Azzermbly EDBEQEEI:;IDH ar Slab [nzulation [nzulation
Perirmeter H - alue H - alue
R | |
_1 Slab-On-Grade should be entered in linear feet |
1 : | 205352 ft2 19.0 a.0
2 - Skylight 1 Click here to select Azze... - 0 ft
3 | “Floor 1 Slab-On-Grade: Unheated | |nsulation: ... - Ga1 ft
4 | i-Basement wall 1 |Solid Concrete or Masonr... . o Insulation ft2 0.0 0.0
5 | i-Basement Wall 2 | Solid Concrete or Masonr... (= | 1 FE 0.0
B | BasementWall 3 |Solid Concrete or Masonr... 2Ft 0.0
7 | =-EsteriorWall 1 |Metal Frame, 16" o.c. - 51 f@ 0.0
8 0 beincdowe 1 Metal Frame, Double Pane  * || Glazing: Tin... * 993 a4
3 Laindioyy 2 Click here to select Asse... - 0 G
10 iy 3 Click here to zelect Asse... 0 ]
11 Do 1 Class - ||Clazing: Cl... - 126 ft2




 Untitled.cck - COMcheck-EZ Code: 2003 |ECC

File Edit View Oplions Code Help
DEE + BR X2 &
| Project Envelope | Lighting | Mechanical |
[ Roof || Skylight || Extwall |[ Int wWal windou
Slab-On-Grade Floors
Caomponent Azsembly i
[ Conztruction Details. . J ||n$ulali|:|n: |
Building Mo Insulation o — depth ity
1 | Floar1 lab-Cn-Grade: Unheatad Hotizontal Insulation » IS
| Wertical Insulation  »|  ZFt
}_ 3t
b SRR |
i_ Continuaus |
Horizontal Insulation (A + B = Insulation Depth)
{If A = B, Enter As Vertical Insulation)
Aln AM '
Vertical Insulation (A = Insulation Depth)
[ 0k ] [ Cancel J
Walid building use areais) must be provided on the Project screen. Envelope | TBD | Lighting| TED

Click the Azsembly fields to display a list of assembly choices. "Other" assembly types are editable.



Mandatory
Requirements

Interior
Lighting Power
Requirements

and

Controls

Switching

The building complies if its total connected power is
no greater than the interior lighting power allowance

Total Connected Interior Lighting
Power (805.4.1) < Power Allowance

(805.4.2)

Entire Building

Partial Building

36



{'ﬂ| EZ-Casestudy.cck - COMcheck-EZ | Code: 2001 IECC
File Edit Wiew Options Code Help

Ded + 2R Xi= &

Project Envelope

T8/T12 Fluarescent

Lighting = Mechanical

Compact Fluarescent HID Incandescent Add Space

Component -liture |0 Freture Description ﬁvl',j';:g E:Ez:ptfnq; Ballast Lal_[?ﬂzrier NI_E:::EFET MEESE
Buiilding

1 |=-Space 1

3 ] i nolic Troffer 48" 712 40w * | Magnetic 4 174 133

3 nghtmg cor_npc_)nents are aolic Troffer | 48" 712 40w * | Magnetic P 4 N 70

4 added by clicking on these aolicTroffer 48" T12 40y ¥ | Magnetic «| 2« 3 70

5 T8 12 Fliorescerm 4 0 7 2 PrEmatic Troffer |24 T12U 400y + | Magnetic P 23 70

B LeT8 I T12 Fluorescent 2 |E 2% 4 Prizmatic Troffer (48" T12 40w ¥ | (Magnetic -

I Lighting Results I;

Allowed Wattage 28233 Proposed Wattage

Envelope | TED

LIse the Options Menu to Arrange Lighting Fidures by Spaces.



EZ-Casestudy.cck - COMcheck-EZ

&l
File Edit View Options Code Help
= = B X L3

&

Code: 2003 IECC

Project | Envelope | Lighting | Kechanical
[ T8/T12 Fluorezcent ][ Compact Fluorescent ][ HID ][ Incandescent ][ Add Space ]
. . - Lamp Description, Lampsz Per Nurmber of Fixture Exemption
g il e [ e Diesa b Y attage Per Lamp Salledd Fistune Fistures W attage Allowance
Building

1 | =-Space 1
21 TG T12 Fluorescent 1 |& 2 % 4 Parabolic Troffer 48" T12 400 - ||Magretic * 4 hd 174 139 |mone b
I b T8/ T12 Fluarescent 6 |B 2% 4 Parabolic Troffer 48" T12 400 - | [Magnetic - 2 - 3 70 Mare -
4 [ e T8/ T12 Fluorescent 3 |C 1 x4 ParabolicTroffer 48" T12 400 - | (Magnetic -+ 2 A 3 7 Mone -
T I, T8/ T12 Fluorescent 4 D 2 2 Prismatic Troffer 24" T120 400y - | (Magnetic - 2 - 53 0 Mone A
B | i T8/ T12 Fluorescent 2 |E 2% 4 Prismatic Troffer (48" T12 400 - ||Magnetic - 2 - 1 7 Mone A
F T8/ T12 Fluorescent 8 lick hereto select L.« 1] 0 Mane

Imvalic of Incomplete Lighting Data

24" TR 17W

24" Tal 32w

24" T12U 40y
24" T12U ES 34W
36" T3 25W

36" T1Z 300

36" T1Z ES 25W
48" T3 32w

45" T10 424

45" T1Z 400

45" T12 ES 32W
45" T1Z ES 34W
48" T12 Slim 39
48" T1Z2 slim E5 32w
&0 TS 40W

96" T3 75W

28" T3 ES 60w
96" T12 Slim 75%W
Other

Alloed Wattage 21936

Froposed Wattage 31186

Ervelope

Lighting

lJse the Options Menu to Arrange Lighting Fixtures by Spaces.




Office A:
Office B:
Bathrooms:
Corridor:
Retail A:
Retail B:
Future:

400 ft?
850 ft?
350 ft?

50 ft?
500 ft?
500 ft?
350 ft?

Office A

Future
Bath- Development
rooms
Corridor
Retail A
Retail B
Office B

Total Building Area = 3000 ft?

39



File Edit

Cil=0l Cptions

@i EZ-Casestudy.cck - COMcheck-EZ
Code Help

Code: 2001 IECC

N N CommentsiDescription (Envelope)
Project Ens
[ T8/T12 Fluoresce eyl ][ Add Space
r v Spaces (Lighting) Lamp D egcription Lamps Per Murnber of Fiuture
P Wattage Per Lamp Bl Fiuture Fiutures W attage
Exemptions and Allowances (Lighting)
Builditg
1 | B-Space 1 A
A R T84 T12 Fluorescent 1 |[& 2 x4 Parabalic Troffer |48 T12 40 | [Macnetic i - 174 139
3| e T8/ T12 Fluorescert 6 [B 2 % 4 Parabolic Trotfer 48" T12 govy v | | Magnetic 2 - 3 70
4| T8/ T12 Fluorescent 3 S 1 x4 ParabolicTroffer | 48" T12 400y - || Magnetic 2 - I /0
= I T8 i T12 Fluorescent 4 [D 2 % 2 Prizmatic Troffer | 24" T120 400 + | | Magnetic 2 - 23 i,
B | e Tar . . . 43" T1 2 4000 * | (Magnetic 2 - 11 7o
Lighting Options:
e Spaces
 Exemptions and Allowances
Allowed Wattage 28295 Proposed YWattage A8k
Envelope | TBD Lighting | -10%

Feady




& EZ-Casestudy.cck - COMcheck-EZ 3.0 Release 1a Code: 2001 IECC z E]b—_(]

File Edit “iew Options Code Help
£ .
DEHE L Rl X©E & |
Project | Envelope | Lighting | KMechanical
[ T8/T12 Fluorescent ][ Compact Fluorescent ][ HID ][ Incandescent (” &dd Space _] >
Lamp Description, L F Mumber af Fit E ti
. . - amp Description amps Per umber o ischLire xemphian
rit Fiature 1D Fiature Dezcrption el B Lot s B allazt Fivture Fitures Waltage
rescent 1 (A& 2 4 Parabolic Troffer 48" T12 40w ¥ |[Magnetic - Ll hd 174 139 Mot b
tescert & B 2 4 Parabolic Troffer 48" T12 40 - | |Magnetic - 2 hd a1 Fil] [ohe b
rezcent 3 |G 1 % 4 ParaholicTroffer 48" T12 40 ¥ |[Magnetic - 2 - 3 Fill] Mone -
" " ————
tescent 4 D 2 2 Prizmatic Troffer 24" T120 400 * | [Magnetic Mone Exemption » [k
rescent 2 B 2 x4 Pristnatic Troffer (48" T12 400 * || Maghetic Special Medical/Dental/Research allowance » i
Professional Sports Arena Playing Field
izallery Museum/Monument: Exhibits
Lighting in Residential Cvwelling Uniks
Emergency Lighting {Aukomatic Conkrol)
{ | *
Alowed YWattage 28235 Proposed Wattage ERLE

Ermelope | +22% | Lighting | -10%

Ready




. e .
PR . e

o

o

ments
Simple Systems (Section 803.2) Complex Systems (Section 803.3)

e 803.2.1 - Heating and cooling e 803.3.1 - Heating and Cooling
loads Loads

e 803.2.2 - HVAC Equipment e 803.3.2 - HVAC Equipment
Performance Requirement Performance Requirement

e 803.2.3 -Temperature & e 803.3.3 —-HVAC System
Humidity Controls Controls

» 803.2.4 - Hydronic System e 803.3.4 — VAV Systems Serving
Controls Multiple Zones

» 803.2.5 - Ventilation e 803.3.5 - Ventilation

» 803.2.6 - Economizers e 803.3.6 - Duct and Plenum

e 803.2.7 - Shutoff Damper Insulation and Sealing
Controls L :

e 803.3.7 - Piping insulation

e 803.2.8 - Duct and Plenum :

Insulation and Sealing e 803.3.8 — System Completion

e 803.2.9 - Piping insulation

42



|"ﬂ| EZ-Casestudy.cck - COMcheck-EZ 3.0 Release 1a
File Edit Wiew Options Code Help

LDEd & @R XS

Project Envelope Lighting ( IMechanical ?

=

Code: 2001 IECC

[ HWALC System ][ Flant ][ W' ater Heating ]

Conporens | Gy | (T | Plel | Coperee
Building

1 | fed WWater Heating 1 2 Click here... J
2 | E-HVAC System 4 1

3 “Rooftop Packaged Hest P Select... j Select... j

4 | [=-HVAC System 1 1

5 “-Rooftop Packaged Hest P =63 kBtuih j Ajr-Cooled j

B |[=-HVAC System 2 7

7 “Rooftop Packaged Hest P =65 kBtuh j Ajr-Coaled j

8 | =-HYAC System 3 2

3 “-Rooftop Packaged Heat P ==80-=133k... j Ajr-Coaled j Ajr Econamizer J

The Mechanical section generates a customized list of mandatory
requirements applicable to the mechanical components you identify.

Envelope | TED

Lighting

LIse the View Menu to display Regquirements.




@i EZ-Casestudy.cck - COMcheck-EZ. Cade: 2001 IECC
File Edit “iew Options Code Help

O d &
| Project || Envelo

[ HvACSystem || F

HVAC System

HWAC Equipment Type:
Heating Equipment Type:

Cooling Equipment Type:

Compondg ® None @ None
Bilding (O Central Furnace () Field-Assembled D System
12 _':"WE!TEI" Hesting 1 (O Duct Furnace ) Hydranic Coil [
3 2 H:.%;E,:;jt;:ai () Hydranic or Stearn Coil () Packaged Terminal D Unit
% | Z-HVAC System | O Heat Pump () Rooftop Package DX Unit
v Packaged Teminal
B fg...HvAHCD;::tpefna; () Radiant Heater LIRpUDICRSIE
£ ~Roofiop Pag () Unit Heater BLLiG
B | [=-HY AT System 3
g 0 Fooftop Pac D il [
Zoning Category:
Single Zone Ferimeter System
multiple Zone Ferimeter system

L OF. J| Cancel |

Erwelope | TED Lighting | -10%

LIse the View Menu to display Reguirements.



id| EZ-Casestudy.cck - COMcheck-EZ Code: 2001 IECC

File Edit “iew Options Code Help

D E & B X e &
Project Envelope Lighting | KMechanical |
[ HWALC System ][ Plant ][ Wwiater Heating J
. E quipment Fuel Type/ Condenser Sustem
Component Duant't}< Capacity Heat Source Type Details
Buildinig
7| Water Hesting 1 2 Click here... -
2 | E-HY AL System 4 1
3 - Rooftop Packaged Heat Pu Select. .. j Select. .. j
4 | =-HvAC System 1 1
a " Rooftop Packaged Heat Py B3 kBtuh - Air-Cooled i
B | =-HwAC System 2 v <65 kBtu'h Lir Cooled
v ---Rooftop Packaged Heat P ==65 - =90 kBtufh Evaporatively Cooled
g |':-|...H_~,.f,.u.,c Systern 3 2 ==90 - <135 kBtu/h aroundwater Coupled
3 +--Rooftop Packaged Heat Py =135 - <240 kBtu/h water Cooled -onamizer o
=240 - =760 kBtu'h
=760 kBtufh
Envelope | TED Lighting | -10%

Use the Wiew Menu to display Reguirements.




& Untitled.cck - COMcheck-EZ
File Edit “iew Qptions Code Help

D f R Xi= &

Code: 2001 IECC

| Project || Env Lighting | Mechanical |
[ HYAC Sypztem Plant “whater Heating ]
Coriansts SisA Equu:umn_ent Fuel Typed Condenser 5_'.-'S|:E':IT|
Al Heatk S nuce Detailz
Building Plant Equipment
Flant Equipment Type:
Boiler Type: Cooling Plant Type:
() Hot Water ) Condensing Unit
() Steam ) Water Chiller
WE | Een
(*) Maone (*) Maone
() (o)
Envelope | TED Lighting | TED

| Use the View Menu to disnlay Reauirements.




File Edit “iew Options Code Help
hexE + B@R X2 &

Code: 2001 IECC

- [B]x]

| Project || Envelope ||
| HvAC Systern || Flant

[ W'ater Heating J

E quiprnent Fuel Typed Condenzer
Sompenzil SHE Capacity Heat Source Type
Builditig
1| vater Heating 1 2 [ Click here ]
2 | E-HwAC System 4 1 : . : |
- : vetem Service Water Heating Details |>(|
3 -Rooftop Packaged Hest Py : ==
4 |5 1 N
= H:\'{AC Shsloiy] [] System Has a Circulation Pump
3 “-Rooftop Packaged Heat PU =65 _
B | O HvAC System 2 7 [ ] Heat Trace Tape Installed in the System
7 ‘.Rooftop Packaged Heat PL =65
Help k. Cancel
. Py ; Lok J | J
9 “-Rooftop Packaged Heat PU - L = O o ] Gl =T R &ir Economizer __'
Envelope TED Lighting | -10%

Lge the View Menu to display Reguirerments.
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» Requirements Checklist generatéd automatically based on input
o applicable code
¢ building location

Parcier Mucksar

Envelope Compliance Certificate
2001 IECC

COfe e cHEZ Sofrandre ¥ erduod 1.0 Fledae 1

e v/ AN Leakage, Component Certification,
and Vapor Retarder Requirements:

All joints and penetrations are caulked,
gasketed, weather-stripped, or otherwise
sealed

Eulidady Locamod (for oeadier dana).
Clukare Zowd

Heardg Degree Daya(base B4 degreed
Coold g Degree Dayaiba By degreea
Frogecr Type.

Vdioe ¢ il Pans,

At Leakage, Tomponett CerHfkation, 40d Yapor RetardeT Requirements
. L jodd add pd AFancdd ded caulkad, gadeared, meamer Inppd, o T Raled.

1. Wadomrg do0rd, ddd Apigbiod cornfed 49 e end g leakage requirddRdn.
1. Cowyrodedt B-valuea 3 U-facoord labeled aa carndued.

48



&ij EZ-Casestudy.cck - COMcheck-EZ

Edit “iew Options Code Help

R Crl+M > e &
CHpen... Clrl+0 F
P , ghting | K echanical
Open Recent — Be sure to save your project
Save e ——eacis B

E o Preview and Print reports
Save As... Quantiy %
FPage Setup... /’/

Frint Preview. .. / 2
1

Frint Repaort... Ctrl+F
Save Report... L P Select...
1
Exit t P =5 kBtuh
=-HW AT Systerm 2 7
. -Rooftop Packaged Hest Py =65 kBtuh
=-HYAC System 3 2
- Fooftop Packaged Heat P ==90 - =135k




& EZ- -Casestudy.cck - COMcheck £ 5.0

—_—
File Edit View Options u:n L \l €

Ij'“' E .H:u E }(: Help Topics

Project Envelope Lightin About COMcheck-EZ..

[ HWAL Spztem ][ Flant ][ Wwater Heating ]

E quiprment Fuel
Capacit Heat

X [+ COMcheck-EZ Help =] E3

Component Quantity

Back Farward nt

Lontents ||ﬂdE.':-: ] Eearch]

COMcheck-EZ

j Tal:ule El:ulumns and Fows

% E;thrl::; You can use COMeheck-EZ2™ to demonstrate that your commercial or

ﬁ Views Men high-rise residential building design complies with the 2000 Edition of
+ @ Options Menu the International Energy Conservation Code (IECC). COMeheck-E2

7] Contest Menu includes a software method and a manual method for demonstrating

2] Code Menu compliance.

E Help Menu

2] Project Screen The COMecheck-E2 software provides a highly flexible way to

# @ Envelops Screen demonstrate compliance with minimal input. The envelope section
+ @ Lighting Screen

11 @ Mechanical Soreen al_lows tradeoffs bemreen_envelope components, Including roofs, walls,
+ @ Buiding Liss Typss wmdcwa, floors, ar_wd Sk\_,xh_ght; The ||_ght|ng section .ena_blea_ you to

+ @ Mandatory Requirements quickly determine if your lighting design meets interior-lighting power
limits. The mechanical section enables you to assemble a customized
list of code requirements that are applicable to the systems and
equipment inyour building.
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*Sigma 2 Bldg.
Floor Plan

9.6

193.6'
- - | - - - - A - - - - - - - - -
) Office Office Office Office Office Office Office Office Office Office Office
Office Office Office
Office Office Office Office Office Office Office Office Office Office Office Office Office Office Office Office Office
Office
Office ggg% Office | Office Office | Office Office Office Office | Office | Office | Office Office | Office Office égg% Office
Office
Janitorial
Office Meris RR .
Office Office Office Office Electrical Office Office Office Office Office
Men's RR
Office
Office Worner's RR Conference
Office Office Office Office Worreris RR Conference Office Office Office Office | Office
Closet Office
Office
Office Office Office Office Office Office Office Office Office Office
PN Office Office
Office /
Kitchen H o Lopby
N Window/ Door Schedule 1 o 5
6 x T Glags Entry Door - single pane tinted 3 %
3 x 7 Opaque Entry Door f
« 36— @ 30" x 46" aluminum, double paned, solar bronzed tint 48 « 36—
80"x 70" aluminum, double paned, solar bronzed tint 4
p
@ 60" x 70" aluminum, double paned, solar bronzed tint 3




*Sigma 2 Bldg.
Building Envelope

Roof: 20,532 sq.ft. Wood truss R-19
Insulation

Exterior Walls: &172 5q.ft. 2 X 4 Metal
Frame at 16” O.C., R-10 Insulation

Walls Perimeter = 681 In. ft.
Windows: 996 sq.ft. Metal Frame, double

pane, tinted, U-value .69, SHGC-Value .57,

P.F..b0O
Window/Wall Ratio = 12%

Glass Doors: 126 oq. ft. Clear Glazing, U-
value .92, SHGC-Value 47

Metal Door: 21 s.f. U-value .70

Floor: 20,552 ¢q. ft./65]1 linear
feet, unheated slab on grade, no
insulation

2 Storage Water Heaters, Electric,
&0 gal. capacity

Activity Areas
Office: 15,649 sq.ft.

Halls/Corridors/Transitions:
5355 s9.ft.

Restrooms: 500 sq.ft.
Kitchen: 505 sq.fT.
Lobby: 340 sq.ft.




*Sigma 2 Bldg.
Lighting Plan — Existing Lighting

96.6-

193.0
10>
- F = F mF m F - F - mF mF mF ﬁ
NAS
Ofi\f‘ A Office A A Office A Fﬂc A Office A A Office A A Office A A Office A A Office A A Office A A Office A A' I
ice Office 5] Office
A [ o] o] o] o] (o] o] o] o] o] o] Cill I
A A A A A A A A A @ A A A A A A A A A I
Office Office Office Office Office Office Office Office Office Office Office Office Office Office Office Office Office
A [o] A A A A A A Office ] A A A A A A A A @] A I
A A
Fe A ' A A A A A A A A A A A A l l N "F
Office ] ogm Office Office Office Office Office Office [o] Office Office Office Office Office Office Office ogm I Office |
R A A A A A A A A A A A A A i .
[o] [o] [o] [o] [o] [o] [o] [p] [o] [o] [o] Office I
A
a i [o] Ja:n%rial L2l -
Office Mer's RR A A A A A A ) A A A A A
A Office Office Office Office o] , Electrical Office Office Office Office Office R | ©
A A A A A A MK H H H A A A A A Office CS
A
) 01| Women's RR Conference ra D] A
. Office mg” 5 R N R A A A ] A A A A A I
F A Office Office Office Office Women's RR Conference Office Office Office Office Office K e
R o Closet = 8 A 8 A A A [o] A A A A A ] Office |
Office [0} o] o] o] o] Dl o] o] Dl ] .
A
o |
.  Office A A Office a 4 Office A A Office a » Office a ic fﬁc A Office A 4 Office A A %fﬁce ) " ¢
N ] Office | 2] Office | ®
YN
Office . h . If] I F F # F A ' |
,\ . . . . = Lighting Schedule # o
o] . 2'x 4' - 3-lamp F32- T8, ParabolicTroffer, [t 017
; Kitchen A electronic ballast, bi-level switching, 89 nominal input watts | 174 N Office
Office ALA A A 2 ' J
x 4' - 2-lamp F32- T8, Parabolic Troffer
F " F electronic ballast, bi-level switching, 59 nomlnal input watts 31 F %
™ —€— 1' x 4' Parobolic Troffer w/ 2 $F32) T8 lamps, 5
electronlc ballast , 59 nominal input watts
@ 2' X 2 lamp F32 - T8 Prismatic Troffer,
electronlc ballast, 59 nominal input watts 53
<66 — > 2'x 4' - 2-lamp F32- T8, Parabolic Troffer <366 — >
electronic ballast, bi-level switching, 59 nomlnal input watts 11
=] 18W compact fluorescent exterior down lights 29
120.6




-Sigma 2 Bldg.
Mechanical Plan

Unit6

Cartier Heatonp
Rooftop Packaged Unit
Model #50R KB
Cooling Capecity = 7-L/2 ors
Heating Output =83,000 Biuhr
Hectric Resistance Heat

Unit 10
Caner Heal
Rooitop Packaged Unit

C00|I 212 tons
Heaung %J\W% 000 Btuhr
Anrﬂovv

7] Lo

R o

Unit5
%aoé"fép%a i
#%R un
=
a ng r
CAM

Units #12,34788&9
Canmier Heatpunp
Roof Top Packaged Unit
Model

Qutput=5tons

Heatlng%%t =58,000 Biuhr




-Building Section

R-19 Batt insulation w/ R-6 rigid insulation

metal truss
5 P2 NN
plenurm
5 7
S ©
© . . .
N aluminum, double glazed, tinted window
——31/2" Metal Framing (16" 0.c.)
— R0 Batt insulation

4" unheated, uninsulated slab




Overhang/Projection Factor (PF)

PF= A/B
PF=0.5




Red Mountain Feed & Irrigation




*Red Mountain Feed & Irrigation

L 25'-0" 25'-0" L 25'-0" L 25'-0" -
HAY STORAGE 20'-0"
7
OFFICE GROOMERY
12'-3"
15'-0"
L — \I
4 WINDOW 3'x7* DOOR
u ‘ 14'-0" ‘6'-0" ‘ 20'-0"
@
o)
o)
D p—
[a)]
h
é 20'-0"
>
o
n
o
8
Q=
% N 150
— 1 — *
(2) 5'x5" WINDOWS I/\ (2) 5'x5" WINDOWS r
8'-0"




Inside Office/Bathroom Storage

60



15-\.0--F" RNIRpINAN] IIRRAREpIAED
i ol | LT

Exterior Walls: 3,954 sq.ft.

»10’ High: R10 between girt & metal wall + 2x4 R11 metal studs,
0.071 u-factor, heat capacity=1 (2,176 sq. ft.)

»5 High: R10 between girt & metal wall (928 sq. ft.)

12'-0 15/16"

OPEN

[
|

8'-0" 50'-0" 20'-0"
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-Red Mountain Feed
Building Envelope

Roof: 5,000 sq.ft. Metal w/1” Styrofoam
thermal block, R-12 Insulation

Exterior Walls: 6,597 sq.ft.

Windows: 144 sq.ft. Metal Frame, double
pane, tinted, U-factor .75, SHGC .88, Fr
DD

Glass Doors: 42 sq. ft., Metal Frame, U-
factor .92, SHGC .67, PF, .25

Window/Wall Ratio = 2.9%

Doors: 100 sq. ft.0verhead Metal, U-value
00, other metal-42’, u-value 1.20

Floor: 50002q.ft./200 linear feet,
unheated slab on grade, R10 2
vertical
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-Red Mountain Feed
Lighting Plan

25-0" 25-0' 25-0" ‘ 25-0"
HAY STORAGE 20"
z \
OFFICE BATH GROOMERY
Himinini
15
Ly R
4" WINDOW 3'x7" DOOR
u ‘ 14'-0" ‘6'-0" ‘ 20-0"
@
[}
o
[a)
o
|
] ] I ] [ ] ] | ] ] £ 20-0"
w
>
(o]
n

3'x7' DOOR

T

—
(2) 5'x5' WINDOWS

| A

(2) 5'x5° WINDOWS

Lighting Schedule

8’ Industrial Fluorescent, 2 F96T12 Slimline Lamps & Energy Saving Magnetic Ballast
43 Fixtures, 173 watts/fixture

2'x4” Troffer 2 F32T8 lamps and GEB, 6 Fixtures, 59 watts/fixture



Pellet Stove
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About the Program

Compliance Tools

Residential (REScheck)

Commercial

Training fEducation
Trainin
State Tre |
Coansu
Energy Codes Glossary
2004 Mational warlkshop

Implementation Tools
CiOE 2004 Proposals
DOE Determinations
DOE Assistance
Resource Materials

Status of State Energy
Codes

Setting the Standard

Technical Support/FAQs

mplementation, and e Drc?et@l I

@ REScheck

REScheck, REScheck -Web, REScheck Package Generator

COMcheck

COMcheok -£5, COMcheok Package Generator

DOE's Building Energy Codes Program is an information resource
on national model energy codes. We work with ather

overnment agencies, state and local jurjsdict) nationg
4Il“. 3 ] e fit, Iy .

The Program recognizes that energy codes maximize energy efficiency only
when they are fully embraced by users and supported through education,

Search energycodes.gov

Search Help

Mare !

arch O pti [

Site Map
HELP - fsk a Codes Expert

EF. f ion Center
; 3 hdly Format

ENTS

2004 National
Workshop on

Jov

B NEWS

REScheck Mow Includes the
2003 IECC

Mewly Released — Sedting the
Standard Update
July 2004

ICC Final Action Hearings
May 17-20, 2004




» Register on-line to receive the latest
up-to-date information on energy
code related issues.

Newsletter
» http://lwww.energycodes.gov/news/

Mareh 20056

U 5. Department of Energy » Office of Energy Efficiency and Renewable Energy

t]:l‘/ Setting the Standard Newsletter

Basements: Advantages and Disadvantages of Finishing
Basements During Initial Construction of the Home

The 2000 and 2003 Editions of the International Energy Conservation Code (JECC) require basement walls to be mnsulated if the
basement 15 considered part of the heated and/or coole ng space (cond:tioned space). If the basement is mitially demizned to

be unfinished, msulation 15 required in the basement ceiling. The 2003 IECC requires floors over unheated spaces or basement
walls that define the conditionsd space (Section 502.2 ) to meet the applicable overall thermal transmittance facter
(U-factor) or the minimum R-value based on the pre specifications on an individual compenent basis. In basic terms

this means, if the basement 15 unconditioned, the foor above the basement (basement ceiling) must be insulated and mest all the
requirements of the JECC for floors over an uncenditioned space. If the basement is considered p: e conditioned building
envelope, the basement walls must be insulated and meet all the requirements of the IECC for basement walls. The requiremants in
the code vary depending on location and climate conditions. Raquirements m the TECC include some of the following: Insulation
Installation {Section 102 .4), Moisture Control (Section 502.1.1), and Caulking and Seall Section 502.14.2)

Many homes are being constructed with unfinished basements to reduce mnitial costs. In most cases, the homeowner sventually finishes
the basement for additional living space by installing basement wall msulation. Beeause most basements are eventually eceupied, the

advantazes and disadvantages of condi £ the basement should be thoroughly reviewed prior to permitting and construction.

1

lation compared to basement ceiling msulation.

Table 1 provides a list of advantages and disadvantages of basement wall 1

i
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» Help Desk — on-line electronic form
http://www.energycodes.qgov/support/helpdesk.php

Emaill
Techsupport@becp.pnl.qov

Pam Cole
Pacific Northwest National Laboratory

U.S. Department of Energy’s Building Energy Codes Program
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